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ImagelJ: Image Processing and Analysis in Java
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ImagelJ: Image Processing and Analysis in Java

i Qué es Imagel?

ImageJ es una herramienta de tratamiento de imagenes
desarrollada por el National Institute of Health cuyo principal
desarrollador es Wayne Rasband.

® Image] File Edit Image Process Analyze Plugins Window Help

800 Image)
I8 o|z[ol<]4|+[nAlo|o] [@[suu]g|4[&] [>]
||magq 1.41d/Java 1.5.013 (430 commands, 30 macros) |

Surge como mejora del ya obsoleto NIH Image y tiene como
principal objetivo dar soporte para herramientas de software de
médico, incorporando utilidades de anadlisis y procesamiento de
imagenes.
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ImagelJ: Image Processing and Analysis in Java

Caracteristicas

Es software de dominio publico con cédigo fuente disponible.

No se trata sélo de un programa, es un framework.

Disefio del software con una arquitectura abierta (plugins).

Portable a distintos sistemas operativos (Java).

Permite scripting y trabajos en lotes (Macros).

Frecuentes actualizaciones con nuevas caracteristicas.
mmndow Help

Macros
Shortcuts
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j Edit...
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Capture Screen  0+®G
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ImagelJ: Image Processing and Analysis in Java

Ventajas

@ Sus facilidades como framework permiten desarrollar nuevos
plugins en cuestién de minutos.
o Existe multitud de cédigo libre de tratatamiento de imdgenes
escrito en Java.
@ Rapidez de computo:
e Ofrece mayor velocidad que soluciones basadas en lenguajes
interpretados como: Matlab o IDL.
e Permite paralelizar operaciones entre bandas.

@ Relativo bajo consumo de memoria (~ 2MB + JVM)

A OO Memory

T85MB (< 1%) ‘
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ImagelJ: Image Processing and Analysis in Java

Contras

@ Dependiente de una mdquina virtual (JVM).
@ Al ser un software de caracter genérico carece de ciertas
prestaciones:
e Sin soporte para georeferenciacion.
e Sin soporte para TIFF multibanda.
@ Documentacion frecuentemente desactualizada.

@ Proporciona métodos de alto nivel de acceso a pixeles y
bandas que cualquier programador no experimentado se
verd tentado a usar de forma poco eficiente.
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ImagelJ: Image Processing and Analysis in Java

Macros

@ Son mas lentas que los plugins basados en Java, pero
permiten automatizar procesos de forma mas rapida.

@ Pueden autocompletar y aceptar los formularios.

@ Lenguaje sencillo y documentado.

@ Permiten hacer casi cualquier tarea.

®00 vim — 81x17 — 83
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ImageJ: Image Processing and Analysis in Java

dirl = getDirectory("Choose Source Directory ");
format = getFormat();
dir2 = getDirectory("Choose Destination Directory ");
list = getFileList(dir1);
setBatchMode (true) ;
for (i=0; i<list.length; i++) {
showProgress(i+1, list.length);
open(diri+list[il);
saveAs(format, dir2+list[il);
close();

}

function getFormat() {
formats = newArray("TIFF", "8-bit TIFF", "JPEG", "GIF", "PNG",
"PGM", "BMP", "FITS", "Text Image", "ZIP", "Raw");
Dialog.create("Batch Convert");
Dialog.addChoice("Convert to: ", formats, "TIFF");
Dialog.show();
return Dialog.getChoice();
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ImagelJ: Image Processing and Analysis in Java

Procesamiento por lotes

También conocido como batch mode:

@ Se invoca con el pardmetro: -batch.

zion/ Image. java -jar ij.jar -batch Hombrefl

o Util para realizar trabajos en segundo plano.

@ Permiten procesar una bateria de imagenes sin necesidad de
arrancar el interfaz de usuario.

@ No requieren conocimientos de Java, simplemente utiliza el
lenguaje de macros.
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ImagelJ: Image Processing and Analysis in Java

Plugins

@ Permiten desarrollar funcionalidades nuevas con toda la
potencia y libertad de Java.

@ Permiten la utilizacién de librerias externas: soporte de
matrices, librerias de tratamiento de imagenes,. ..

@ Permiten utilizar toda la potencia de ImageJ: llamadas a otros
plugins, acceso directo a arrays de pixeles,. ..

@ Permiten la utilizacidon de nuevo hardware.

o Imagel esta constituido casi en su totalidad de plugins.
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ImagelJ:

Image Processing and Analysis in Java

Ejemplo de plugin: “ROI recta

import
import
import
import

public

ij.k;
ij.plugin.filter.PlugInFilter;
ij.process.*;

ij.gui.*;

class ROI_rectangular implements PlugInFilter {

public int setup(String args, ImagePlus imp) {

}

return DOES_ALL;

public void run(ImageProcessor ip) {

GenericDialog gd = new GenericDialog("Seleccione origen y datos de la regién");
gd.addNumericField("Origen X:", 0, 0, 5, "");
gd.addNumericField("Origen Y:", 0, 0, 5, "");
gd.addNumericField("Anchura:", 0, 0, 5, "pixeles");
gd.addNumericField("Altura:", 0, 0, 5, "pixeles");
gd.showDialog();
if (gd.wasCanceled()) { return; }
WindowManager.getCurrentWindow() .getImagePlus() .setRoi((int) gd.getNextNumber(),
(int) gd.getNextNumber(), (int) gd.getNextNumber(), (int) gd.getNextNumber());
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ImageJ: Image Processing and Analysis in Java
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ImagelJ: Image Processing and Analysis in Java

Limitaciones

Pese a no ser un problema de ImageJ actualmente existe una serie
de factores que pueden limitar la cantidad de memoria a utilizar:
@ Un PC de 32bits sélo podra utilizar a lo sumo ~ 3,0GB.
@ Ya practicamente sélo se venden computadores de 64bits sin
embargo hay que tener en cuenta que:
e Algunos fabricantes instalan versiones de Windows de 32bits
independientemente de la aquitectura de la maquina.
e La maquina virtual de Java ha de ser la de 64bits.

® 7 7 Memory (64-bit)

Maximum Memory: |3500 | MB
Parallel Threads for Stacks: 2

Cancel oK
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ImagelJ: Image Processing and Analysis in Java

Recursos

Existen multitud de recursos para ImageJ:
@ Plugins y macros:
e http://rsb.info.nih.gov/ij/plugins/index.html
@ Lista de correo: listserv@list.nih.gov
@ Documentacién:

http://rsb.info.nih.gov/ij/docs/index.html
http://rsb.info.nih.gov/ij/developer/index.html
http://imagejdocu.tudor.lu/
http://www.imagingbook.com/
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ImageJ: Image Processing and Analysis in Java

Conceptos basicos

Resolucidn espacial — tamano del pixel
Resolucién espectral — rango de frecuencias
Resoluciéon radiométrica — niveles de gris

o
o
o
e Tamaio de la imagen — nimero de pixeles
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ImagelJ: Image Processing and Analysis in Java

Manejo de Imagel

Winpows XP

ile I.Ed\t Image Process Analyze Pluging Window Help
|8 & ||| 4|41 ] Al o] ] 2| @ |[psfse] ] 7| 4 | 8] |> ]
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ImageJ: Image Processing and Analysis in Java

i Nombrede  mamaiio de
Nimero la banda la imagen Escala de
de bandas grises  Memoria
\ [XeXe) / Stack gé /
/4 (QE_url _X2); 1024x1024 pixels; 1o-bit; SME

Pixeles
banda
actual

Ventana de imagen
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ImagelJ: Image Processing and Analysis in Java

iQué es un Stack?

Muiltiples Imagen
imagenes multibanda

QB_urbano_X.
1024x1024 pixels: 16-bit; ;
O 0O O Stack (16.7%)
374 (QB_urbano_X3); 1024x;

QB_urbano_X.
0241024 pixels: 16-bit. :

QB_urbano_X
1024x1024 pixels; 16-bit;

Slicer
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ImagelJ: Image Processing and Analysis in Java

iQué es un Stack?

Image) File Edit lm Process Analyze
»

Plugins Window Help

Type
Adjust »
Show Info... k)
Properties... O#BP
Color »
Add Slice

Hyperstacks » Delete Slice

Next Slice [>]
Crop. o#X Previous Slice [<]
Duplicate... %D Set Slice...
Rename...
Scale... e
Translate... Stack to Images
Rotate » Make Montage...
Zoom » Reslice [/]...

Z Project...
Lookup Tables » 3D Project...

Plot Z-axis Profile

Start Animation [\]
Stop Animation
Animation Options...
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ImagelJ: Image Processing and Analysis in Java

Composiciones de color RGB

Image) File Edit Im Process Analyze Plugins Window Help

Type »
Adjust »
Show Info... 8l
Properties... {¥®P
RGB Split
Stacks »> RGB Merge...
Hyperstacks > Stack to RGB
Make Composite
Crop OEX | Show LUT
Duplicate... {¥D Edit LUT...
Rename. Color Picker... %K
Scale... BE
Translate...
Rotate »
Zoom >
Lookup Tables »
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ImageJ: Image Processing and Analysis in Java

Composiciones de color RGB

800 Nueva Pila (RGB) (50%)
| 1024x1024 pixels; RGB, 4MB
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ImagelJ: Image Processing and Analysis in Java

Tipos de imagen soportados

Escala de grises de 8bits (byte)
Escala de grises de 16bits (ushort)
Escala de grises de 32bits (float)

Composiciones RGB de 24bits (int)
Image) File Edit Im Process Analyze Plugins Window Help

Type »
Adjust »>
Show Info.. ®1
Properties... {r3%P
RGE S
Stacks »> RGB Merge..
Hyperstacks ¢
Make Composite
Crop DEX T Show LUT
Duplicate... %D Edit LUT...
WLl Color Picker... 08K
Scale... . S
Translate...
Rotate 4
Zoom >

Lookup Tables >
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ImagelJ: Image Processing and Analysis in Java

Escalado

Image] File Edit Im Process Analyze Plugins Window Help
>

Type

Adjust »
Show Info... 21

Properties... %P
Color »
Stacks »
Hyperstacks »
Crop G8X
Duplicate... 43D
Rename...

Scale... 3#E
Translate...

Rotate »
Zoom »

Lookup Tables >
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ImagelJ: Image Processing and Analysis in Java

Escalado

8,00 Scale

X Scale (0.05-25): 0.5
¥ Scale (0.05-25): 0.5
Width (pixels): 512

Height (pixels): 512

~ Interpolate
™ Create New Window

Title: |Q8_urbano_X1-1.{

_Cancel ) [ OK
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ImagelJ: Image Processing and Analysis in Java

Histogramas

Image) File Edit Image Process mm Plugins Window Help
Measure BM
Analyze Particles...
Summarize
Distribution...
Label
Clear Results
Set Measurements...

Set Scale...

Calibrate...

Plot Profile K
Surface Plot...

Gels »

Tools »
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ImagelJ: Image Processing and Analysis in Java

Histogramas

® O O Histogram of SPOT_AGUA X1

[
0 255

Count: 1048576 Min: 5
Mean: 87.907 Max: 218
StdDev: 29.090 Mode: 86 (31216)

e Tarrewn e Value: 163
List J( Copy ) (Log ) coune: 272
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ImagelJ: Image Processing and Analysis in Java

Histogramas

Image] File Edit Image Process Analyze .]m Window Help

Macros >
Shortcuts »
Utilities »
New...

Edit...

Compile and Run...

Fusiones
10
Indices calidad
Transformadas
Editor de stacks
e Filtro Elipsoidal
Igualar Histograma
Actualizar |JFusion

RGB Histogram

»
»
>
»
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ImagelJ: Image Processing and Analysis in Java

Histogramas

© O O Histogram of SPOT_AGUA_xs.tif
/5 (Green); 300x240 pixels; 8-biy 211K

[
0 255

Count: 1048576 Min: 15
Mean: 75.410 Max: 255
StdDev: 28.120 Mode: 84 (18944)

— G
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ImagelJ: Image Processing and Analysis in Java

Filtros

Image] File Edit Image Im Analyze Plugins Window Help
{+38S

Smooth

Sharpen

Find Edges

Enhance Contrast

Noise »

Shadows »

Binary »

Math >

FFT »
Gaussian Blur...

Image Calculator... Median...

Subtract Background... Mean...

Repeat Command  {+38R . Minimum...
Maximum...
Unsharp Mask...
Variance...

Show Circular Masks...
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ImagelJ: Image Processing and Analysis in Java

Filtros

8,00 Convolver...

_Open... Save...

™ Normalize Kernel
1 Preview

Cancel 0K
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ImagelJ: Image Processing and Analysis in Java

Filtros

konos_Corte_Vina_B2-1.tif (33.3%)

“1024x 1024 pixels; 8-bit; IMB M O O Ikonos_Corte Vina_B2.tif (33.3%)

10241024 pixels; 8-bit; IMB
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ImagelJ: Image Processing and Analysis in Java

Asignacion de memoria

Image) File IEE. Image Process Analyze Plugins Window Help
8Z

Undo

Cut 8X
Copy #C
Copy to System
Paste

Paste Control..

Clear

Clear Outside

Fill 8F

Draw #D

Invert RiEd)

Selection »
Line Width...
Input/Output...
Fonts...
Profile Plot Optiens...
Point Tool....
Colors..
Appearance...
Conversions...

Proxy Settings...
Misc...
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ImagelJ: Image Processing and Analysis in Java

Asignaciéon de memoria

® 7 7 Memory (64-bit)

Maximum Memory: asud MB
Parallel Threads for Stacks: 2

_Cancel ) [ OK
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ImagelJ: Image Processing and Analysis in Java

Documentacién y ayuda

Image) File Edit Image Process Analyze Plugins Window .:aﬂ
Image) Website...

Image]) News...
Documentation...
Installation...
Search Website...
List Archives...

Plugins...
Macros...

Source Code...
Macro Language...
Macro Functions...

About Plugins >
About Image]...
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IJFusion: una extension de ImagelJ para la fusion de imagenes

@ !JFusion: una extensién de ImageJ para la fusién de imagenes
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IJFusion: una extension de ImagelJ para la fusion de imagenes

1JFusion

http://www.ijfusion.es
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IJFusion: una extension de ImagelJ para la fusion de imagenes

i Qué es IJFusion?

IJFusion actualmente es una serie de plugins, que permiten
extender la funcionalidad de ImageJ al campo de la fusién de
imagenes, y surge como solucion a los siguientes problemas:

@ Necesidad de implementar algoritmos de fusién propios.
@ Alto coste de las licencias del software comercial disponible.

@ Implementaciones en lenguajes interpretados como Matlab
imponen limitaciones de memoria y resultan lentos.

@ Necesidad de recopilar dichos algoritmos en una herramienta.

o Existen tareas repetitivas que podrian automatizarse.
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IJFusion: una extension de ImagelJ para la fusion de imagenes

i Qué permite hacer |JFusion?

Implementacién de diversos algoritmos de fusién: PCA, IHS,
Atrous, MDMR,. ..

Implementacién de diversos algoritmos de indices de calidad
para evaluar la calidad de las imagenes fusionadas: Zhou,
ERGAS, QU,...

Soporte para TIFF multibanda de 8 y 16bits.

Herramientas varias: editor de pilas, simulated annealing,. ..



IJFusién PARA LA FUSION DE IMAGENES DE SATELITE
IJFusion: una extension de ImagelJ para la fusion de imagenes

Plugins wrapper

IJ Fusion
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IJFusion: una extension de ImagelJ para la fusion de imagenes

iDe qué forma pretende mejorar |JFusion?

IJFusion es una herramienta en constante desarrollo, hasta ahora el
objetivo primordial era extender ImageJ. Lentamente converge en
un framework de fusién de imagenes cuyas pretensiones son:

@ Permitir la implementacién de nuevos algoritmos de fusion e
indices de calidad en cuestién de minutos.

@ Posibilidades de aplicar nuevas opciones a los algoritmos de
fusion independientemente de su implementacion.

@ Eliminar la dependencia con ImagelJ, pero seguir soportandolo
mediante plugins.

@ Soporte para la fusién de imagenes ‘grandes’ (> 500MB).
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IJFusion: una extension de ImagelJ para la fusion de imagenes

ImagelJ plugins

wrapper

IJFusion

core
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IJFusion: una extension de ImagelJ para la fusion de imagenes

Aplicacion A IJFusion

externa P

I core
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IJFusion: una extension de ImagelJ para la fusion de imagenes

Plugins de IJFusion que utilizaremos

Macros >
Shortcuts
Utilities >
New...

Edit...

Compile and Run...

v

Fusiones

10

Indices calidad
Transformadas
Utilidades

yYvYVYT YyTyrT
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IJFusion: una extension de ImagelJ para la fusion de imagenes

Editor de stacks

Nos permite crear stacks a partir de las imagenes y pilas ya
abiertas sin tener que cerrar ninguna.

Image] File Edit Image Process Analyze l:m Window Help

Macros >
Shortcuts >
Utilities >
New...

Edit...

Compile and Run...

Fusiones >
10 >
Indices calidad >
Transformadas »>
Editor de stacks
o Filtro Elipsoidal
Igualar Histograma
Actualizar |JFusion
RGB Histogram
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IJFusion: una extension de ImagelJ para la fusion de imagenes

Editor de stacks

Seleccion Afadir Bandas
debanda  PHminar - panda  Crear nueva
banda imagen imagen
A0OC \ Creacioh de pila...
il Image) Wl Nueva Imagen
¥ @ QB_urbano_XS.tif || Banda 3
] ["| Banda 2
|| Banda 2 || Banda 1
[| Banda 3
[ Banda 4 >
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IJFusion: una extension de ImagelJ para la fusion de imagenes

TIFF Multibanda

Las versiones actuales de ImageJ soportan TIFF multipdgina pero
no TIFFs multibanda.

Qs XS.tif.

8.0.0 TiffDecoder
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IJFusion: una extension de ImagelJ para la fusion de imagenes

TIFF Multibanda

[JFusion aiade soporte de lectura y escritura de TIFF multibanda:

Image] File Edit Image Process Analyze Iim Window Help

Macros »
Shortcuts »
Utilities »
New...
Edit...
Compile and Run...
Fusiones »
Lector TIFF Multibanda
Indices calidad » Escritor TIFF Multibanda
Transformadas >

Utilidades »
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IJFusion: una extension de ImagelJ para la fusion de imagenes

TIFF Multibanda

ImageJ soporta imagenes de 8, 16 y 32bits. Algunos productos son
suministrados con escalas de grises distintas (ej: QB suele usar
11bits), detalle que debera ser indicado al lector para una correcta

visualizacion:
@ 7 ) Numero de bits:

Numero bits por pixel: | 11] | bits

Cancel OK
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IJFusion: una extension de ImagelJ para la fusion de imagenes

TIFF Multibanda

QB_urbano_XL.tif (25%
102451024 pixels; L6_bit;

QB_urbano_X1.tif (25%
102451024 pixels; L6_bit;

® O O Histogram of QB_urbano_X1

[ —
229 1094

Count: 1048576

Min: 229

Mean: 383.379 Max: 1094

StdDev: 80.374
Bins: 256

Mode: 380 (27305)
Bin Width: 3.379

(het) (Comy ) (Log) Velue: 516.207

_Copy

Lo ) count: 2918
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IJFusion: una extension de ImagelJ para la fusion de imagenes

Fusiéon de imagenes

D O O SPOT_AGUA pan.tif (33.3%) O O O Fusionada mediante MDMR 33.3%) __
10291024 e e 474 (Eanda Fus (onada 41, 1024<1029 pixels; 8-bis; ME

O O O SPOT_AGUA_.
474 (Banda 45 1024x1024
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IJFusion: una extension de ImagelJ para la fusion de imagenes

Métodos de fusidn que utilizaremos

Image] File Edit Image Process Analyze Iim Window Help

Macros >
Shortcuts >
Utilities »
New...
Edit...

Compile and Run...

BTN Vediante PCA

10 » Mediante IHS
Indices calidad > Mediante Atrous
Transformadas > Mediante MDMR
Utilidades >
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IJFusion: una extension de ImagelJ para la fusion de imagenes

Funcionamiento general de las fusiones

@ Requieren tener como ventana activa un stack con la imagen
multibanda o en algoritmos de fusién que lo permitan
simplemente una banda.

@ Tras seleccionar el método de fusién se solicitard la imagen
pancromatica.

@ Dependiendo del algoritmo se mostraran unas opciones de
fusién u otras.

@ Automaticamente realizard el proceso de escalado de la
multibanda y realizard la fusién, dando como resultado un
stack nuevo con la imagen fusionada.
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IJFusion: una extension de ImagelJ para la fusion de imagenes

indices de calidad

Nos permiten en mayor o menor medida determinar algiin aspecto
de la calidad de la imagen fusionada (generalmente resolucién
espacial o resolucién espectral).

800 QU Map with bar (33.3%)
TOL7< 1017 pi IME
| 7
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IJFusion: una extension de ImagelJ para la fusion de imagenes

Indices de calidad que utilizaremos

Image] File Edit Image Process Analyze lim Window Help

Macros >
Shortcuts >
Utilities >
New...
Edit...
Compile and Run...
Fusiones >
10 >
C Correlacion
Transformadas » Ergas espacial
Utilidades » Ergas espectral

Qu
Zhou
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IJFusion: una extension de ImagelJ para la fusion de imagenes

Funcionamiento general de los indices de calidad

@ Requieren tener como ventana activa un stack con la imagen
fusionada por alguno de los algoritmos de fusién.

@ Tras seleccionar el indice deseado se solicitara la imagen
pancromatica o la multibanda dependiendo del tipo de indice.

@ Se solicitardn parametros adicionales que dependerdn del tipo
de sensor y del tipo de indice.

@ Automaticamente se calculard el indice deseado y se
mostrara en pantalla.
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Métodos de fusion clasicos

@ Métodos de fusion clasicos
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Métodos de fusion clasicos

Algoritmos de fusién clasicos

Se basan en la idea de:

@ Encontrar una transformacién de la imagen en la que una de
las componentes sea similar a la imagen pancromatica.

@ Sustituir dicha componente con la imagen pancromatica.

@ Deshacer la transformacién.

En concreto vamos a ver:
@ PCA: Anilisis de componentes principales.

@ IHS: Transformacidn intensidad-matiz-saturacién.
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Métodos de fusion clasicos

Fusién mediante PCA

La transformacion estd basada en el andlisis de componentes

principales.

pancromatica fusionada

multiespectral

Q

La componente a sustituir sera la primera.
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Anilisis de Componentes Principales

e cov(X,Y) == — W= =

n

@ A = matriz de autovectores en orden descendente.
e Y =Ax(X—-Mx)t
e X = (A x Y)' + Mx
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Anilisis de Componentes Principales
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Opciones de fusion PCA

® 7 7 Configuracién f...

™ Rescalar visualizacién

Normalizacién: |8 | bits
™ Interpolacién lineal
) Modo depuracion

Cancel OK
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Ejemplo de fusién PCA

800 Fusionada PCA (33.3%)
1024x1024 pixels; RGB; 4MB
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Desventajas fusion PCA

@ Gran consumo de memoria.
@ Calculos computacionalmente complejos.

@ Resultados espectrales bastante pobres.
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Fusién IHS (Intensity Hue Saturation)

La transformacién esta basada en la transformacién del sistema de
color de RGB a IHS.
multiespectral

La componente a sustituir serd la componente / (intensidad).
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Transformacion IHS

_ R _ G _ B
® '=RrrGcTB 8 = R¥G+B b= rrcrs
0,5-[(r— —b
@ h = arccos (Fgg;(figggjg)z he[0,n] parab<g

0,5:[(r—g)+(r—b)]

T e h € [r,27] para b > g

° h:27r—arccos(

@ s=1-—3-min(r,g,b) s € [0,1]

o j=RIELB s € [0,1]
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Transformacion IHS

Sin embargo en la practica se aplica una transformacién matricial:

1 1 1
Vi = —]-T _? 6 G
Vo 72 —% O— B_
R’ 1 *\% \% [ Pan
Gl=[1 -+ -2 vi
, 2 V2
B 1 V2 0 | V2 |
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(16.7%)

P S
SPOT_AGUA_.. 1024x 1024 pixels; &-bit; I

1024x1024 pixels; 8-bit; 1F
r

IHS

7 SPOT_AGUA SPOT_AGUA_.
1024><1024 pixels; 8-bity 1N 10241024 pixels; 8-bit; 1N
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FIHS (Fast IHS)

fl = R+G+B
o 3

R’ R+ (Pan—1)
G'|=|G+(Pan—1)
HR
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Ejemplo de fusion IHS

Multiespectral (33.3%)
1024x1024 pixels; RGB: 4MB

80 Fusionada IHS (33.3%)
1024x1024 pixels; RGB; 4MB
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Caracteristicas fusion IHS

@ Algoritmo de fusién répido (opera pixel a pixel).
@ Resultados espectrales razonables.
o Utilizado como base para multitud de algoritmos.

@ Como desventaja requiere de 3 bandas, solventable utilizando
FIHS.
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O O Multiespectral (25%) O Fusionada PCA (25%)
1024x1024 pixels; RGB: 4MB 1024%1024 pixels; RGB; AMB

O Fusionada IHS (25%)
1024x10: 4mxe|s RGB; 4MB

: O Fusionada Brovey (25%)
1024x1024 pixels; RGB; 4MB
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@ Técnicas de mejora de fusién



IJFusién PARA LA FUSION DE IMAGENES DE SATELITE

Técnicas de mejora de fusion

Mejoras tipicas

El término ‘mejora’ es muy relativo, depende de lo que deseemos
conseguir. Normalmente son criterios que afectaran a la resolucién
espacial y espectral. Ejemplos tipicos son:

@ Interpolar el reescalado.
@ Matching de histogramas.

@ Ponderaciones y pardmetros ‘tradeoff’.
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Interpolacién

Existen multitud de métodos de interpolacién a utilizar en el
proceso de escalado de la multibanda al tamaifio de la
pancromatica:

Vecino mas préximo
Bilinear
Bictbica

Lanczos
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Interpolacién: Vecino mas préximo




IJFusién PARA LA FUSION DE IMAGENES DE SATELITE

Técnicas de mejora de fusion

Interpolacién: Hermite
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Interpolacién: Bilinear
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Interpolacién: Lanczos
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Matching de histograma

SPOT ACUA )(2 f (33.3%)

Histogram of SPOT_AGUA_X2

| —
0 2
Count: 1048576 Min: 15
Mean: 75.410 Max: 25
StdDewv: 28.120

Mode: 84 (18944)

/—\Lm z—mpy /—Log value: 97

Count: 8896

I
0 2
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Matching de histograma

Histogram B
256x 128 pixels; B-bit;, J2K

listogram A

256 128 pixels; B-bit, 32K

Cumulative Histogram B
256128 pixels; 8-bit; 32K,

Cumulative Histogram A
256128 pixels; 8-bit; 32K

800

Log

Cumulative Histogram A (
256128 pixels; 8-bit; 32K,

listogram A (mod)

256128 pixels; 5-bit; 32K

5->0

6->0

7->16
8->29
9->34
10 -> 38
11 -> 44
12 -> 49
13 -> 55
14 -> 60
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Matching de histograma

SPOT_AGUA

\_X2.tif (33.3%)
T IME

@, Panc. matching (33.3%)
1024 pixels; 8-bit; IME

O Histogram of SPOT_AGUA_X2

Histogram of Panc

[ — [ —
0 2

0 255

Count: 1048576 Min: 15
Mean: 75.410 Max: 25

5
ﬁ StdDev: 28.120 Mode: 84 (18944)

(List ) (Copy ) (Log ) Uotwer 7 (List ) (Copy ) (Log )
4

Count: 1048576 Min: 16
Mean: 77.840 Max: 255
stdDev: 27.948 Mode: 84 (88955)
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Matching de histograma

Existen dos posibilidades en el ajuste de histograma multi-pan:
@ Realizar ajuste antes de fusionar.

@ Realizar ajuste después de fusionar (la implementada).

Image] File Edit Image Process Analyze Iﬂm Window Help

Macros >
Shortcuts >
Utilities »
New...
Edit...
Compile and Run...
Fusiones »
[[¢] >
Indices calidad 4
Transformadas >
Editor de stacks
T Filtro Elipsoidal

Actualizar |JFusion
RGB Histogram
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Ponderaciones

Suelen ser simples factores mediante a los que se puede dar un
cierto porcentaje de peso a determinados pardmetros:

R+0,75%xG+0,25%xB

Ejemplo: [ = 3

@ ;Cémo encontrar el valor 6ptimo de los factores?

@ ;Cudl es el coste computacional de dicho proceso?
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Parametros ‘tradeoff’

Son un tipo especial de ponderaciones que normalmente tienen por
objetivo modificar el comportamiento del algoritmo de fusién
dependiendo de un parametro.

Ejemplo: algoritmo de Te-Ming Tu basado en Brovey-IHS

@ ;Cémo encontrar el valor 6ptimo de los pardmetros?

@ ;Cudl es el coste computacional de dicho proceso?
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Simulated Annealing: bisqueda de parametros 6ptimos

valor
inicial

energia

minimo
local

optimo

-inf inf
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Simulated Annealing: bisqueda de parametros 6ptimos

@ Necesario un criterio que determine como mejorar un valor
inicial aleatorio (energia = indice de calidad).

Existe un pardmetro T y un AT que definirdn el ndmero de
iteraciones.

La precicision del salto dependera de la iteracién actual.

Se aceptan soluciones peores con un factor de probabilidad P.

Podemos definir un umbral de calidad deseada.
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